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Agenda 
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• Introduction 

• Startup 

• Remote Display Debugging 

• UI Navigation and Process 

Control 

• Action Points 

• Data Monitoring and 

Visualization 

• Debugging for Parallel 

Applications 
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Agenda 
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• Memory Debugging with 

MemoryScape 

• Batch Debugging 

• Reverse Debugging with 

ReplayEngine 

• What’s New in TotalView 8.10 

• Support and Questions 
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INTRODUCTION 

4 
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What is TotalView? 

• Wide compiler & platform  
support 

• C, C++, Fortran 77 & 90, 
UPC 

• Unix, Linux, OS X 

• Handles Concurrency 

• Multi-threaded Debugging 

• Parallel Debugging 

• MPI, PVM, Others 

• Remote and Client/Server 
Debugging 

• Integrated Memory 
Debugging 

• Reverse Debugging 

• ReplayEngine 

• Supports a Variety of Usage 
Models 

• Powerful and Easy GUI 

• Visualization 

• CLI for Scripting 

• Long Distance Remote 
Debugging 

• Unattended Batch 
Debugging 5 

A comprehensive debugging solution for demanding 

parallel and multi-core applications 
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Supported Compilers and Architectures 

• Platform Support 

• Linux x86, x86-64, ia64, Power 

• Mac Intel 

• Solaris Sparc and AMD64 

• AIX 

• Cray XT, XE, XK 

• IBM BGL, BGP 

• Cell 

• Languages / Compilers 

• C/C++, Fortran, UPC, Assembly 

• Many Commercial & Open Source Compilers 

• Parallel Environments 

• MPI  

• MPICH1& 2, Open MPI, Intel MPI, SGI MPT & Propack, SLURM, 
poe, MPT, Quadrics, MVAPICH1 & 2, Bullx MPI, & many others )

 
 

• UPC 

6 
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STARTUP 

7 
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Starting TotalView 
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Start New Process 
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Starting TotalView 
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Start New Process – Select a recent process 
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Starting TotalView 
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Start New Process – Arguments tab 
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Starting TotalView 
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Start New Process – Command-line Args 
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Starting TotalView 
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Start New Process – set environment variables 
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Starting TotalView 
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Start New Process – Standard I/O redirection 
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Starting TotalView 
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Attach to Process 
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Starting TotalView 

15 

Open a Core File 
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Starting TotalView 

Normal 

totalview [ tv_args ] prog_name [–a prog_args ] 

 

Attach to running program  

totalview [ tv_args ] prog_name –pid PID#  [–a prog_args ]  

 

Attach to remote process 

totalview [ tv_args ] prog_name  –remote name [–a prog_args ] 

 

Attach to a core file 

totalview [ tv_args ] prog_name corefile_name [ –a prog_args ] 

Via Command Line 
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REMOTE DISPLAY 

DEBUGGING 

17 



©Copyright 2012 Rogue Wave Software, Inc. ©Copyright 2012 Rogue Wave Software, Inc. 

Remote Display Client 

• Offers users the ability to easily set up and 

operate a TotalView debug session that is 

running on another system 

• Consists of two components 

• Client – runs on local machine 

• Server – runs on any system supported by TotalView 

and “invisibly” manages the secure connection between 

host and client 

• Remote Display Client is available for: 

• Linux x86, x86-64 

• Windows XP, Vista, 7 

• Mac OS X 
18 
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Remote Display Client 

• Free to install on as many clients as needed 

• No license required to run the client 

• Only the server running TotalView requires licenses. 

Must be version 8.6 or later of TotalView or version 2.4 

or later of MemoryScape. 

• Presents a local window that displays 

TotalView or MemoryScape running on the 

remote machine 

• Requires SSH and X Windows on Server 

19 
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Remote Display Client 

• User must provide information necessary to 

connect to remote host 

• Connection info can be saved for reuse 

• Information required includes: 

• User name, public key file, other ssh information 

• Directory where TotalView/MemoryScape is located 

• Path and name of executable to be debugged 

• If using indirect connection with host jump, each host 

• Host name 

• Access type (User name, public key, other ssh information) 

• Access value 

• Client also allows for batch submission via 

PBS Pro or LoadLeveler 

20 
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Remote Display Client 

21 
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Session Profile Management 

• Connection information can be saved as a 

profile, including all host jumping information 

• Multiple profiles can be generated 

• Profiles can be exported and shared 

• Generated profiles can be imported for use by 

other users 

22 
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UI NAVIGATION AND 

PROCESS CONTROL 

23 
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• State of all processes 

being debugged 

• Process and Thread 

status 

• Instant navigation access 

• Sort and aggregate by 

status 

Root Window 

 

Status Info 

•T = stopped 

•B = Breakpoint 

•E = Error 

•W = Watchpoint 

•R = Running  

•M = Mixed 

•H = Held 

Interface Concepts  
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TotalView Root Window 
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Host name 

Action Point  

ID number 

Expand - Collapse 

Toggle Process  

Status 

TotalView  

Thread ID # 

Rank # 

(if MPI program) 

Hierarchical/ 

Linear Toggle 

• Dive to refocus 

• Dive in new window to get a second process window 
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Process Window Overview 

26 

Toolbar 

Stack Frame Pane 

Source Pane 

Tabbed Area 

Stack Trace Pane 

Provides detailed 

state of one process, 

or a single thread 

within a process 

 

A single point of 

control for the 

process and other 

related processes 
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Stack Trace and Stack Frame Panes 
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Language Name Frame Pointer Local Variables Register Values 

• Click to refocus 

  source pane 
• Click to modify 

• Dive for variable window 
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Source Code Pane 

28 

View as Source - or Assembly - or Both! 
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Tabbed Pane 

Action Points Tab 

all currently defined 

action points  

Processes Tab  

all current 

processes 

Threads Tab:  

all current 

threads, ID’s, 

Status 
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Process Status 

Process/Thread 

status is available at 

a glance, in both the 

Process and Root 

Windows 

30 
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Search Paths 

31 
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Preferences 

32 
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Finding Functions, Variables,  
and Source Files 

33 
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Stepping Commands 
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Based on 

PC location 
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Stepping Commands 

35 
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Using Set PC to resume execution at an 

arbitrary point 

36 

• Select the line 

• Thread->Set PC 

• Click Yes to set 

the PC 
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ACTION POINTS 

37 
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Breakpoints 

 

Barrier Points 

 

Conditional 

Breakpoints 

 

Evaluation Points 

 

Watchpoints 

 

Action Points 
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Setting  Breakpoints 

• Setting action points 

• Single-click line number 

• Deleting action points 

• Single-click action point line 

• Disabling action points 

• Single-click in Action Points Tab Pane 

• Optional contextual menu access for all 

functions 

• Action Points Tab  

• Lists all action points 

• Dive on an action point to focus it in 

source pane 

• Action point properties 

• In Context menu 

• Saving all action points 

• Action Point > Save All 
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Setting  Breakpoints 
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• Breakpoint->At 

Location… 

• Specify function 

name or line # 

• Specify class name 

and break on all 

methods in class, 

optionally with 

virtuals and 

overrides 



©Copyright 2012 Rogue Wave Software, Inc. 

Setting  Breakpoints 
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• Breakpoint 

type 

• What to stop 

• Set conditions 

• Enable/disable 

• In 1 process or 

share group 
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Evaluation Breakpoint… 

Test Fixes on the Fly! 

42 

• Test small source code 
patches 

• Call functions 

• Set variables 

• Test conditions 

• C/C++ or Fortran 

• Can’t use C++ 

constructors 

• Use program variables 
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 TotalView understands C++ templates and gives you a choice ... 

 

 

 

 

 

 

 

 

Boxes with solid lines around line numbers indicate code that exists at 

more than one location. 

Setting  Breakpoints 

With C++ Templates 
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Watchpoints 

• Watchpoints are set on a 

specific memory region 

• Execution is stopped 

when that memory 

changes 

44 

Action Point -> 

Create 

Watchpoint… 
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Watchpoints 

• Can create from a 

variable window 

using Tools -> 

Watchpoint 

45 
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Watchpoints 

• Can create from 

right-click on 

variable in 

Source pane 

46 
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Watchpoints 

• Watchpoints are set on a memory region, not 

a variable 

• Watch the variable scope and disable 

watchpoints when a variable is out of scope 

• Can be conditional, just like other action 

points 

• Use $newval and $oldval in your evaluation to find 

unexpected changes in value (such as a loop value 

changing by more than 1) 

47 
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LAB 1: THE BASICS 

48 
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DATA MONITORING AND 

VISUALIZATION 

49 
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Diving on Variables 

You can use Diving to: 

… get more information 

… open a variable in a Variable Window. 

… chase pointers in complex data structures 

… refocus the Process window Source Pane 

You can Dive on: 

… variable names to open a variable window 

… function names to open the source in the Process Window. 

… processes and threads in the Root Window. 

How do I dive? 

•Double-click the left mouse button on selection 

•Single-click the middle mouse button on selection. 

•Select Dive from context menu opened with the right mouse button 
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Diving  

51 

Diving on a Common 

Block in the Stack 

Frame Pane 
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Undiving 

52 

In a Process Window: retrace the path that has been explored with 

multiple dives.  

In a Variable Window: replace contents with the previous contents. 

You can also remove changes in the variable window with Edit > Reset 

Default.  
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The Variable Window 

53 

 

• Click once on the value 

• Cursor switches into edit more 

• Esc key cancels editing 

• Enter key commits a change 

• Editing values changes the memory of the 

program 

 

• Window contents are updated 

automatically 

• Changed values are highlighted 

• “Last Value” column is available 

 

 

Editing Variables 
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Expression List Window 
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• Reorder, delete, add 

• Sort the expressions 

• Edit expressions in place 

• Dive to get more info 

 

• Updated automatically 

• Expression-based 

• Simple values/expressions 

• View just the values you want to monitor 

Add to the expression list using contextual menu with right-click on a 

variable, or by typing an expression directly in the window 



©Copyright 2012 Rogue Wave Software, Inc. 

Viewing Arrays 
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Data Arrays 

Structure Arrays 
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Array Viewer 

• Variable Window select Tools -> Array Viewer 

• View 2 dimensions of data 

• Can be an arbitrary slice through a higher dimensional data cube 

• Can be strided 

56 
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Slicing Arrays 

Slice notation is     [start:end:stride] 

57 
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Filtering Arrays 

58 
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Visualizing Arrays 
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•Visualize array data using Tools > Visualize from the 

Variable Window 

•Large arrays can be sliced down to a reasonable size 

first 

•Visualize is a standalone program 

•Data can be piped out to other visualization tools 

•Visualize allows to spin, 

zoom, etc. 

•Data is not updated with 

Variable Window; You 

must revisualize 

•$visualize() is a directive 

in the expression system, 

and can be used in 

evaluation point 

expressions. 
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Dive in All 

60 

Dive in All will display  

  an element in an array  

        of structures as if  

             it were a simple array. 
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Looking at Variables across Processes  
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• TotalView allows you to 

look at the value of a 

variable in all MPI 

processes 

• Right Click on the 

variable  

• Select the View > View 

Across 

• TotalView creates an array  

indexed by process  

• You can filter and visualize 

• Use for viewing distributed 

arrays as well. 
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Typecasting Variables 
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• Edit the type of a variable 

• View data as type… 

• Often used with pointers 

 

• int[10]*  Pointer to an array of 10 int 

• int*[10]  Array of 10 pointers to int 

Type Casts Read from Right to Left 

•    Cast float * to float [100]* to see a dynamic array’s values 

•    Cast to built-in types like $string to view a variable as a null-terminated 

string 

•    Cast  to $void for no type interpretation or for displaying regions of 

memory 

The Bottom Line 

Give TotalView a starting memory address and you can tell TotalView how 

to interpret your memory from that starting location. 
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Typecasting a Dynamic Array 

63 
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C++ Class Hierarchies 
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Note: 

• Virtual public base classes appear each time they are referenced 

• The vtable entry here is part of the C++ implementation but can provide useful 

information 

Variable Window shows class hierarchy using indentation 

• derived2 inherits from base1 and derived1 

• derived1 inherits from base1 

Example: 
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Fortran 90 Modules 

Tools > Fortran Modules 

65 
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STLView 
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STLView transforms templates into readable and 

understandable information 

–STLView supports std::vector, std::list,  std::map, std::string 

–See doc for which STL implementations are supported 



©Copyright 2012 Rogue Wave Software, Inc. 

STLView 

67 

STLView transforms 

templates into 

readable and 

understandable 

information 
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LAB 2: VIEWING, EXAMING,WATCHING AND 

EDITING DATA 

68 
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DEBUGGING FOR 

PARALLEL APPLICATIONS 

69 
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TotalView Startup with MPI 

70 

In the Parallel tab, select: 

your MPI preference, number of tasks, and number of nodes. 

… then add any additional starter arguments 
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TotalView Startup with MPI: old school 

 

IBM totalview poe -a myprog -procs 4 -rmpool 0 

QUADRICS 
Intel Linux 

under SLURM 

totalview srun -a -n 16 -p pdebug myprog 

MVAPICH 
Opteron Linux 

under SLURM 

totalview srun -a -n 16 -p pdebug myprog 

SGI totalview mpirun -a myprog -np 16 

Sun totalview mprun -a myprog -np 16 

MPICH mpirun -np 16 -tv myprog 

MPICH2 

Intel MPI 

Totalview python –a ‘which mpiexec’ –tvsu 

-np 16 myprog 

 

The order of arguments and executables is important, 

and differs between platforms. 

71 
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Architecture for Cluster Debugging 

72 

 

• Single Front End (TotalView)
 

 

• GUI 

• debug engine 

• Debugger Agents (tvdsvr)
 

 

• Low overhead, 1 per node 

• Traces multiple rank processes 

• TotalView communicates 
 directly with tvdsvrs 

• Not using MPI 

• Protocol optimization 

 

Compute Nodes 

Provides Robust, Scalable and efficient operation with Minimal 
Program Impact 
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Process Control Concepts 

• Each process window is always focused on a specific 
process. 

• Process focus can be easily switched 

• P+/P-, Dive in Root window and Process tab 

• Processes can be ‘held’ - they will not run till unheld. 

• Process > Hold 

• Breakpoints can be set to stop the process or the 
group 

• Breakpoint and command scope can be simply 
controlled 

73 
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Basic Process Control 

74 

•Control Group 

–All the processes created or attached together 

Groups 

•Share Group 

–All the processes that share the same image 
•Workers Group 

–All the threads that are not recognized as 
manager or service threads 

•Lockstep Group 

–All threads at the same PC 

•Process, Process (Workers), Process (Lockstep) 

–All process members as above 

•User Defined Group 

–Process group defined in Custom Groups dialog 
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Call Graph 

75 
Dive on a node in the call graph to create a Call Graph group. 

• Quick view of 

program state 

• Each call stack is a 

path 

• Functions are nodes 

• Calls are edges 

• Labled with the MPI rank 

• Construct process 

groups 

• Look for outliers 
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Parallel Preferences 

 

76 
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Subset Attach 

• Connecting to a subset of a job reduces 

tokens and overhead 

• Can change this during a run 

• Groups->Subset Attach 

77 
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View MPI Message Queues 

78 

• Information visible 
whenever MPI rank 
processes are halted 

• Provides information from 
the MPI layer 

• Unexpected messages 

• Pending Sends 

• Pending Receives 

• Use this info to debug 

• Deadlock situations 

• Load balancing 

• May need to be  
enabled in the MPI library 

• --enable-debug 
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Message Queue Graph  

79 

• Hangs & 
Deadlocks 

• Pending  
Messages 

• Receives 

• Sends 

• Unexpected 

• Inspect 

• Individual  
entries 

• Patterns 
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Message Queue Graph  

80 

•  Filtering  

• Tags 

• MPI Communicators 

• Cycle detection  

• Find deadlocks 

Message Queue 
Debugging  
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LAB 3: EXAMINING AND CONTROLLING A 

PARALLEL APPLICATION 

81 
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MEMORY DEBUGGING 

WITH MEMORYSCAPE 

82 
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What is a Memory Bug? 

• A Memory Bug is a mistake in the 

management of heap memory 

• Failure to check for error conditions 

• Leaking: Failure to free memory 

• Dangling references: Failure to clear pointers 

• Memory Corruption  

• Writing to memory not allocated 

• Overrunning array bounds 

83 
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Why Are Memory Bugs Hard to Find? 

84 

• Memory problems can lurk 

• For a given scale or platform or problem, they may not be fatal 

• Libraries could be source of problem 

• The fallout can occur at any subsequent memory access through 

a pointer 

• The mistake is rarely fatal in and of itself 

• The mistake and fallout can be widely separated 

 

• Potentially 'racy' 

• Memory allocation pattern non-local 

• Even the fallout is not always fatal. It can result in data corruption 

which may or may not result in a subsequent crash 

 

• May be caused by or cause of a 'classic' bug 

 

What is a Memory Bug? 
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The Agent and Interposition 
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Process 

TotalView 

Malloc API 

User Code and Libraries 
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The Agent and Interposition 

86 

Malloc API 

User Code and Libraries 

Process 

TotalView 
Heap Interposition 

Agent (HIA)

 

 
Allocation 

Table 

Deallocation 

Table 
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TotalView HIA Technology 

 

• Advantages of TotalView HIA Technology 

 

• Use it with your existing builds 

• No Source Code or Binary Instrumentation 

• Programs run nearly full speed 

• Low performance overhead  

• Low memory overhead 

• Efficient memory usage  

• Support wide range of platforms and compilers 

87 
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Memory Debugger Features 

• Automatically detect allocation problems 

• View the heap  

• Leak detection 

• Block painting 

• Memory Hoarding 

• Dangling pointer detection 

• Deallocation/reallocation notification 

• Memory Corruption Detection - Guard Blocks 

• Memory Comparisons between processes 

• Collaboration features 

88 
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Enabling Memory Debugging 
Memory Event Notification 

89 
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Memory Event Details Window 

90 
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Heap Graphical View 

91 
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Leak Detection 

• Leak Detection 

• Based on Conservative 

Garbage Collection 

• Can be performed at any point 

in runtime 

• Helps localize leaks in 

time 

• Multiple Reports 

• Backtrace Report 

• Source Code Structure 

• Graphically Memory 

Location 

 

92 
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Dangling Pointer Detection 

93 
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Memory Corruption Report 

94 
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Memory Comparisons 

95 

• “Diff” live 

processes 

• Compare processes 

across cluster 

• Compare with 

baseline 

• See changes between 

point A and point B 

• Compare with saved 

session 

• Provides memory 

usage change from 

last run 
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Memory Usage Statistics 

96 
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Memory Reports 

97 

• Multiple Reports  
• Memory Statistics 

• Interactive Graphical 
Display 

• Source Code Display 

• Backtrace Display 

• Allow the user to 

• Monitor Program 
Memory Usage  

• Discover Allocation 
Layout 

• Look for Inefficient 
Allocation 

• Look for Memory 
Leaks 
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•Preview: Debugging Memory with MemoryScape 

• Startup 

• Integrated and Bundled with TotalView 

• Typically started from the TotalView gui  

• Multi-threaded and multi-process programs 

• Setup from TotalView or stand alone. 

• The multi-process and multi-threaded GUI interface is very similar to TotalView. 

•Automation Support 

•Block painting 

•Memory Corruption Detection - Guard Blocks 

•Memory Hoarding 

MEMORY DEBUGGING: MEMORYSCAPE  
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Memory Debugging: MemoryScape 

99 

• Memory debug many processes at the same time 
• MPI 

• Client-Server 

• Fork-Exec 

• Compare 
two runs 

• Remote  
applications 

• Mutli-threaded  
applications 

Multi-Process and Multi-Thread 
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Script Mode - MemScript 

• Automation Support 

• MemoryScape lets users run tests and check 

programs for memory leaks without having to be in 

front of the program 

• Simple command line program called MemScript 

• Doesn’t start up the GUI 

• Can be run from within a script or test harness 

• The user defines 

• What configuration options are active 

• What thing to look for 

• Actions MemoryScape should take for each type of 

event that may occur  
100 

Memory Debugging: MemoryScape  



©Copyright 2012 Rogue Wave Software, Inc. 

 

 

Menu Selections: 

 

Block painting, Guard block and Hoarding 

101 

Memory Debugging: MemoryScape  
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Red Zones instant array bounds detection for Linux  

 

• Red Zones provides: 

• Immediate detection of memory overruns. 

• Detection of access violations both before and after the bounds of  

allocated memory.  

• Detection of  deallocated memory accesses. 

• Red Zones events  

• MemoryScape will stop your programs execution and raise an event 

alerting you to the illegal access.  You will be able to see exactly where 

your code over stepped the bounds.  

 

Memory Debugging: MemoryScape  
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Memory Debugging: MemoryScape  
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Red Zones instant array bounds detection for Linux  

  

• Red Zones allocation size range controls 

• The optional use of Red zones will increase the memory 

consumption of your program.    

• Controls are provided to allow the full management of Red Zone 

usage. These controls allow: 

• Restriction of red zones to allocations in several user defined size 

ranges 

•  Easily turning red zones on and off at any time during your 

programs execution.  
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Memory Debugging: MemoryScape   

104 

Red Zones instant array bounds detection for Linux  

  

• Red Zones support in the CLI  

• The Command Line Interface also provides support for 

RedZones 

• Scripting support of new commands and command 

qualifiers 

• TVScript  

• MemScript  
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Memory Debugging: MemoryScape   

105 

Configuring Guard Blocks 
 

Guard allocated memory 
When selected, the Memory Debugger writes guard blocks before 

and after a memory block that your program allocates 

 

 

 

 

 

 
 

Pre-Guard and Post-Guard Size: 

 Sets the size in bytes of the block that the Memory Debugger places 

immediately before and after the memory block that your program 

allocates 

 

Pattern: 

 Indicates the pattern that the Memory Debugger writes into guard blocks. 

The default values are  0x77777777 and 0x99999999 
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Memory Corruption Detection (Guard Blocks) 

106 
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Memory Debugging: MemoryScape    

107 

Improved Memory Hoarding support 

The use of memory hoarding in MemoryScape increases the risk of running out 

of available memory.  MemoryScape now has the capability to manage this 

condition and alert you when you are at risk.   

• Hoard Low Memory Controls  

• Automatically release hoarded memory when available memory gets low, 

allowing your program to run longer  

• Hoard Low Memory events  

• MemoryScape can stop execution as notification that the hoard droppped 

below a particular threshold.   This provides an indication that the program is 

getting close to running out of memory.  

• Hoard Low Memory scripting and CLI support 

• TVScript  

• MemScript  
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Memory Debugging: MemoryScape  
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Improved Memory Hoarding support 

 

• Hoard Low Memory support in the CLI  

• Hoard Low Memory scripting support  

• TVScript  

• MemScript  
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LAB 4, 5, 6: MEMORY LABS 
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BATCH DEBUGGING 

Using scripts for unattended debugging 
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tvscript and memscript 

• A straightforward language for unattended 

and/or batch debugging with TotalView and/or 

MemoryScape 

• Usable whenever jobs need to be submitted 

or batched 

• Can be used for automation 

• A more powerful version of printf, no 

recompilation necessary between runs 

• Schedule automated debug runs with cron 

jobs 

• Expand its capabilities using TCL 
111 
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Output 

• All of the following information is provided by 

default for each print  

• Process id 

• Thread id 

• Rank 

• Timestamp 

• Event/Action description 

• A single output file is written containing all of 

the information regardless of the number of 

processes/threads being debugged 
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Sample Output 

• Simple interface to create an action point 

-create_actionpoint ”#85=>print foreign_addr” 

• Sample output with all information 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

! Print 

! 

! Process: 

!   ./TVscript_demo (Debugger Process ID:  5, System ID:  2457@127.0.1.1) 

! Thread: 

!   Debugger ID:  5.1, System ID:  3077191888 

! Rank: 

!   0 

! Time Stamp: 

!   05-14-2012 17:11:24 

! Triggered from event: 

!   actionpoint 

! Results: 

!    err_detail = { 

!      intervals = 0x0000000a (10) 

!      almost_pi = 3.1424259850011 

!      delta = 0.000833243988525023 

!    } 

! 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
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Events 

• General 

• any_event 

• Source code debugging events 

• actionpoint 

• error 

• Memory events (just a few, all are listed in 

Chapter 4 of TotalView Reference Guide) 

• any_memory_event 

• free_not_allocated 

• guard_corruption 

• rz_overrun, rz_underrun, rz_use_after_free 
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Actions 

• Source code 

• display_backtrace [-level num] [numlevels] [options] 

• print [-slice {exp}] {variable | exp} 

• Memory 

• check_guard_blocks 

• list_allocations 

• list_leaks 

• save_html_heap_status_source_view 

• save_memory_debugging_file 

• save_text_heap_status_source_view 
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Command syntax 

• General syntax 

• tvscript [options] [filename] –a [program_args] 

• MPI Options 

• -mpi starter     starter comes from Parallel tab dropdown 

• -starter_args “args for starter program” 

• -nodes 

• -np or –procs or –tasks 

116 



©Copyright 2012 Rogue Wave Software, Inc. ©Copyright 2012 Rogue Wave Software, Inc. 

Command syntax 

• Action options  

• -create_actionpoint “src_expr[=>action1[,action2] …]” 

• Repeat on command line for each actionpoint 

• -event_action “event_action_list” 

• event1=action1,event2=action2 or event1=>action1,action2 

• Can repeat on command line for multiple actions 

• General options 

• -display_specifiers “display_specifiers_list” 

• -maxruntime “hh:mm:ss” 

• -script_file scriptFile 

• -script_log_filename logFilename 

• -script_summary_log_filename summaryLogFilename 
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Command syntax 

• Memory debugging options 

• -memory_debugging  (must use for debugging memory) 

• -mem_detect_leaks 

• -mem_detect_use_after_free 

• -mem_guard_blocks 

• -mem_hoard_freed_memory 

• -mem_hoard_low_memory_threshold nnnn 

• -mem_paint_all 

• -mem_paint_on_alloc 

• -mem_paint_on_dealloc 
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Command syntax 

• Memory debugging red zone options 

• -mem_red_zone_overruns 

• -mem_red_zones_size_ranges min:max[,min:max]… 

• Ranges can be 

• min:max 

• min: 

• :max 

• fixed 

• -mem_red_zones_underruns 
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Script Files 

• Instead of putting everything on the command 

line, you can also write and use script files 

• Script files can also include TCL 

• Logging functions 

• tvscript_log msg – logs msg to the log file 

• tvscript_slog msg – logs msg to the summary log file 

• Property functions 

• tvscript_get_process_property process_id property 

• tvscript_get_thread_property thread_id property 
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Script Files 

• Action point and event functions 

• tvscript_create_actionpoint source_loc_expr 

• [[##image#]filename#]line_number 

• function_name 

• class class_name 

• virtual class:signature 

• tvscript_add_actionpoint_handler id handler 

• tvscript_add_event_handler event handler 

• Passes an array to handler, event will either be error or 

actionpoint 

• Other information relevant to event 

• Handlers are written in TCL 
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LAB 7: BATCH MODE DEBUGGING WITH 

TVSCRIPT 
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REVERSE DEBUGGING 

WITH REPLAYENGINE 
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What is ReplayEngine? 

• Provides record for deterministic replay 

• Records program changes as they happen 

• Captures input 

• Function calls 

• Network and file I/O 

• Captures non-determinism 

• Forces single threaded execution 

• Records context switches 

• Allows stepping back in execution, like a DVR for your 

programs 

• Use breakpoints and watchpoints 

• Support for MPI on Ethernet, Infiniband, Cray XE Gemini 

• Support for Pthreads, and OpenMP 
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ReplayEngine Support 

• Replay on Demand: enable it when you want it 

• Supported on Linux for x86 and x86_64 

• Cluster interconnects 

• IP (any interconnect): MPICH, MPICH2, OpenMPI, Intel 

MPI, SGI MPT, Cray XT-MPT, MVAPICH, MVAPICH2 

• Mellanox Infiniband 

• IB verb: MVAPICH, MVAPICH2, OpenMPI, 

Intel MPI 

• Qlogic Infiniband 

• PSM: MVAPICH, MVAPICH2, OpenMPI, 

Intel MPI 
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ReplayEngine 

• Editing during record mode 

• Allows modification of variables during record 

mode (eval breakpoints, click/edit of variable 

values) 

• Modifications are recorded along with the rest 

of the execution 

• Not allowed to change values when in 

playback mode 

• Don’t attempt to step into recorded edits, but 

correct values show up on either side 
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ReplayEngine 
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An Intuitive User Interface 

 

Step forward 

over functions 

Step forward 

into functions 

Advance forward out 

of current  

Function, after the call 

Advance forward to 

selected line  

Step backward over 

functions 

Step backward into 

functions 

Advance backward out of  

current Function, to before 

the call 

Advance backward to 

selected line 

Advance forward to 

“live” session 
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ReplayEngine 
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Replay not running 

Replay running 

No Active Buttons! 

Enable Replay “On Demand” 

Active Buttons 
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Example 

ReplayEngine 
 

Consider the following very difficult program scenario: 

 

• A crash occurs that destroys the stack backtrace, giving no 
information leading up to the problem 

 

• ReplayEngine can be used to work backwards from the 
crash, and even to observe the stack recreate itself, 
providing the critical information on where and how the 
problem began. 

 

• The ReplayEngine provides the ability to review any part of 
the program execution… to see all variables and function 
calls, from the beginning of the run to the current time 
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LAB 8: REVERSE DEBUGGING WITH REPLAY 

ENGINE 
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New Capabilities in TotalView 8.10 

CUDA 4.1 

Reverse Debugging 

Replay on Demand  

C++View and ReplayEngine interop 

Visual Dive Indicator 

Cray-specific enhancements 

Improved Cray Compiler Edition Support 

ReplayEngine on Cray XE 

CUDA support on Cray XK 

Early Access Preview for OpenACC on the Cray with CCE 8 compiler 

TVScript Scalability Improvements 

32 user bugs fixed 
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SUPPORT AND 

QUESTIONS 
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TotalView Customer Support 

• Email: tvsupport@roguewave.com 

• Use our web site for documentation, demos, 

FAQs and to contact support 
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TotalView Customer Support 
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http://www.roguewave.com 
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TotalView Customer Support 
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TotalView Documentation 
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TotalView Documentation 
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Thanks! 
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QUESTIONS? 


